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A simulator for teaching MR image contrast behavior 
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A computer program to create magnetic resonance images simulating the main features of a 
magnetic resonance imaging (MR) machine was developed on a personal computer. The simulated 
MR images are calculated using the relevant equations describing a chosen pulse sequence on the 
basis of proton density, T~ and T2 images acquired from whole-body MR equipment. The imaging 
parameters (i.e., TR, TE, TI, etc.) are provided by the user. This program produces highly realistic 
simulated images and includes features such as choice of echo time, inversion time, repetition time 
and flip angle, as well as standard features of image display programs such as setting of window 
level/width, zooming and region of interest definition. A novel additional feature is the ability to 
define artificial pathologies in user-defined areas by specifying changes in the relaxation times a~ld 
proton density. The simulator has been developed for teaching and training purposes. A prototype 
version has been used for teaching MRI with extremely positive reactions from students. 
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INTRODUCTION 

The mechanisms which influence and change image 
contrast in magnetic resonance imaging (MRI) are 
quite complex [1]. Understanding the relationship 
among image contrast, pulse sequences and sequence 
parameters is difficult and often requires much intu- 
ition and imagination. Therefore, there is a need for 
teaching tools beyond textbooks and slide presentations. 

The best teacher is an MR machine itself. However, 
learning by experience is time-consuming, expensive 
and, in cases with human pathology, impossible. 
Thus, the next best tool is an MRI simulator; a 
computer program that simulates the images obtained 
with an MR machine without performing real exami- 
nations. This article describes an MRI simulator which 
runs on inexpensive and easily available computers of 
the PC family. 

DESIGN PRINCIPLES 

Cognitive theories and experiments suggest that stu- 
dents learn better and faster when they have the 
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opportunity of actively participating in the process. In 
addition, it has been demonstrated that feedback is 
essential in all teaching situations [2-4]. The reasons 
behind these principles are beyond the scope of this 
article but are basically related to learning and cogni- 
tive processes [5]. A simulator represents an optimal 
tool incorporating both principles. First, the student is 
required to operate the simulator and is thus an active 
participant. Second, the results of the operations are 
displayed on the screen and provide immediate feed- 
back to the student. 

Thus, the MR Image simulator has been designed 
according to the following guidelines [2]: 

• The user should be in control. 
• The response to the user's actions must be as fast 

as possible. 
• It should be possible to reverse all actions with as 

little effort as possible. 
• The program should not allow the user to make 

serious mistakes. 
• The same actions must always lead to the same 

result. 
• The same visual coding used on the screen must 

always have the same meaning. 

Both the preprocessor (described in the next sec- 
tion) and the simulator have been developed using 
object-oriented methods [6]. The class hierarchies 
have been designed in a way that makes it easy to 
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Fig, 1. The mixed-mode sequence currently being used consists of a multiecho spin echo (SE) sequence interleaved with a 
multiecho inversion recovery (IR) sequence. TE is echo time (for SE), TI is Inversion Time, TRIR is the time between a 90 ° SE 
pulse and the closest fol lowing 90 ° IR pulse, TRsE is the time between the 90 ° pulse after the TI interval and the closest 
fo l lowing 90 ° SE pulse. Typical parameters on the 1.5-T machine for an acquisition from the head were TE 50 ms, TRsE 
760 ms, T1360 ms and TRIR 2220 ms. This gave a total scan time of approximately 20 min. 

extend the systems with new functions. In addition, 
the user-interface part of the system has been sepa- 
rated from the application program, making it easier 
to move the simulator to another platform (e.g., 
Macintosh or UNIX). 

The simulator has been implemented on a personal 
computer running Microsoft Windows 3.1 (Microsoft 
Corp., Redmond, WA, USA). The programming envi- 
ronment was Borland C++3.1 with Applications 
Frameworks (Borland Corp., Scotts Valley, CA, USA). 

Fig. 2. The simulator at startup. Actions are selected from the menu bar. Only the File menu can be selected at this point. All 
other menus are disabled. See the text for further details. 
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The Borland Resource Workshop and Borland 
Object Windows were used to develop the user 
interface. 

terns (Philips Gyroscan T5 II 3 at 0.5 T and S15-HQS at 
1.5 T). The number of averages was 4, and the image 
size was 256 x 256. 

METHODS 

Data acquisition 
As a basis for all of the calculations performed by the 
simulator, proton density (p), T1 and T~ values are 
required for each pixel in a particular image. In order 
to achieve this, image data of real examinations were 
obtained by running a mixed-mode pulse sequence as 
shown in Fig. 1 [7, 8]. Although not as accurate as 
multipoint fitting using inversion recovery (IR) and 
multiple spin-echo (SE) sequences, this method is 
much less time-consuming and provides reasonably 
accurate values. This kind of raw data acquisition was 
performed for the most popular normal anatomical 
views and for a number of slices through pathologies. 

On the basis of these data, p, T1 and T~ for every 
picture element in the image were calculated [9]. Data 
acquisition was performed on two whole-body sys- 

Data processing 
The raw data were transferred from the MR machines 
to a personal computer and processed using a spe- 
cially designed preprocessor. The purpose of the 
preprocessor is to build a database consisting of 
anatomical views. In most cases, a list of predefined 
artificial lesions is connected to each anatomical view. 
The preprocessor performs the following functions: 

• The raw data values can be edited interactively. 
• Artifical lesions can be defined for each set of raw 

data (each anatomical view). Each lesion may 
consist of an arbitrary number of distinct or 
overlapping regions of any shape and size, allow- 
ing simulations of composite lesions. Simulation 
of injection of contrast agents is possible. 

• Compression of the raw data. The purpose of the 
compression is not to reduce the space occupied 

Fig. 3. The user has selected the spin-echo sequence and the simulator displays the corresponding dialog box, Upon 
clicking OK or pressing the ENTER key, the box is closed and a spin-echo image is calculated on the basis of the parameters 
in the dialog box and displayed. 
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by the raw data but rather speed up the simula- 
tion process. The speed is typically improved by a 
factor of 5-12, depending on the raw data and the 
compression rate. A high compression rate will, in 
general, give faster simulations at the cost of a 
lower image quality. 

The resulting data (including the predefined artifi- 
cial lesions) were written to a database which is 
scanned by the simulator every time a specific anatomi- 
cal view is required. 

Image simulation 

By using steady-state equations describing inversion 
recovery, spin echo, different gradient echo and spe- 
cific RARE sequences, the simulator is able to calculate 
artificial MR images pixel by pixel based on user 
specified sequence parameters. 

For spin echo, the following equation was used [1]: 

I = p(1 - e(T~-TR)/T1))e -T#T2 

For inversion recovery, the following equation was 

used [1]: 

t = p(1 - 2e -T1/TI + e -T~/T~) 

The equations for the gradient echo sequences were 
obtained from Refs. 10 and 11. These equations as- 
sume perfect 90 ° and 180 ° pulses and a rectangular 
slice profile. Flow and diffusion effects were neglected. 
In addition, the inversion recovery calculation as- 
sumes a short echo time thus allowing T2 effects to be 
neglected. 

In general, in the calculations for the gradient echo 
sequences T2 was used rather than T2*. This will result 
in errors at long TE values or at interfaces between 
regions of different susceptibilities. Flow effects that 
are characteristic of gradient echo sequences are not 
present because the raw images of p, T1 and T2 are 
spin-echo images. Similarly, the Ta dependence of the 
chemical shift is absent for the same reason. 

The simulator offers the following functions: 

• Setting of Window Level and Window Width. 
• Definition of regions of interest (ROIs). ROIs can 

Fig. 4. The spin-echo image which was defined in Fig. 3. In the upper right corner, a description of the imaging parameters 
and the field strength are displayed. 
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be of any shape and size; this function displays 
minimum, maximum and mean intensity, num- 
ber of pixels in the ROI, and the average p, T1 and 
T2 values for the defined region. 

• Zooming. 
• Selection of predefined artificial lesions; when the 

user works with a specific view, the simulator 
automatically loads the artificial lesions defined 
for this anatomical view and makes them acces- 
sible via a pop-up menu; the predefined lesions 
cannot be altered by the user. 

• Definition of artificial lesions; in addition to select- 
ing predefined lesions, the user can define artifi- 
cial lesions himself; the properties of already 
defined (user-defined) lesions can be altered, 
allowing the simulation the injection of contrast 
agents, such as Gd compounds. 

• Saving/loading of user-defined lesions; the le- 
sions defined by the user can be saved and loaded 
in a later session with the simulator. 

The simulator also allows the user to work with 

several images simultaneously, making it possible to 
compare different pulse parameters both qualitatively 
(i.e., visually) and quantitatively (i.e., by using ROIs). 
As the program performs simulations based on real 
image data, this means that it can give realistic simula- 
tions of pathologies based on patient raw data. The 
program is able to calculate and display a simulated 
image in 2-3 s. 

User interface 

This section, together with the captions for Figs. 2-7, 
gives a detailed description of the user interface. 

As shown in Fig. 2, the simulator has a standard 
Windows 3.1 user interface. The actions are issued 
from the menu bar. The images are displayed on the 
black area (the drawing area) below the menu bar. The 
gray area to the right of the drawing area is used for 
displaying information about the image and the cur- 
rent artificial lesion (if any). When the user starts the 
program, only the File menu can be selected. The other 
functions need more information and are thus deacti- 

Fig. 5. Four images are displayed at the same time, allowing the user to compare the effect of different settings. An artificial 
lesion (acute multiple sclerosis plaque) consisting of one region has been inserted. To the right, the p 7-1 and 7-2 values for 
this region are displayed. The white frame indicates the active image. 
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vated (disabled). This prevents the user from perform- 
ing any illegal actions. The first action taken by a user 
is to select File~Open. The simulator will then present a 
list of all cases in the database. After selecting a case, 
the data will be loaded into the simulator, and the 
Draw item is activated. The user can now select a 
sequence from the Draw pull-down menu. After the 
selection of a sequence, the program responds by 
displaying the corresponding dialog box. Figure 3 
shows the dialog box for the spin-echo sequence. The 
user can enter the TR and TE values by using either the 
keyboard or by manipulating the scroll bars. When the 
user has defined a sequence, the image is displayed, 
and all menu items are activated. As seen in Figs. 3-7 
one image is always surrounded by a white frame. The 
frame indicates the current active image. Operations 
(ROI definitions, zooming, setting of window level/ 
width, etc.) are performed on the active image. The 
user selects the active image by pointing at it and 
clicking with the left or right mouse button. A maxi- 
mum of four images can be displayed simultaneously. 

An image is displayed in a free space on the 
drawing area, if possible. When the drawing area h~s 
been filled with images, the current active image is 
substituted by the new image. 

The user defines a ROI or an artificial lesion by 
manipulating the mouse. How the mouse works de- 
pends on the shape selected. The following shapes are 
available: 

• Ellipse 
• Rectangle 
• Pixel 
• Freehand (unrestricted) drawing 

In the ROI menu, the above shapes are directly 
accessible. In the Lesions menu, they can be selected 
from the Shape submenu. When a lesion consisting of 
more than one region has been defined, the values for 
the last defined region are displayed. If the user wants 
information on one of the other regions, he clicks on it 
using the left mouse button. A region can be redefined 
by double-clicking on it. In order to remove a region, 
the user clicks with the right mouse button while 
pointing at it. Artificial lesions are calculated and 
displayed immediately. 

Zooming is done by selecting Zoom In or Zoom Out 
in the Zoom pull-down menu. 

When selecting the Window Level~Width menu item, 
a dialog box is displayed, allowing the user to set the 
window level and window width for the active image. 

Fig. 6. Four inversion recovery images with increasing T/values. The dramatic change in the contrast is as expected [1]. 
MAGMA (1994) 2(4) 
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Fig. 7, A ROI has been defined in the upper left image. The ROI was defined by pressing the left mouse button, dragging the 
mouse, and releasing the button. The simulator displays the ROI information in a dialog box. Four different shapes are 
available: ellipse, rectangle, pixel and freehand (unrestricted) drawing. 

COMPUTER REQUIREMENTS 

The following configuration is needed to run the 
program: 

• 386/486 personal computer with hard disk 
• Microsoft Windows 3.1 
• VGA or SuperVGA screen 
• Minimum 4MB memory. 

A computer with mathematical coprocessor is recom- 
mended due to the large amount of floating-point 
calculations. A Super VGA screen with 256 colors is 
recommended; the 256 colors give 64 gray levels 
compared to the 16 gray levels on a standard VGA 
screen. However, for most purposes, any VGA screen 
should suffice. In order to study the finer details in an 
image, the quality of the screen also becomes impor- 
tant. 

EXAMPLES 

Because it is an interactive tool, it is impossible in the 
present article to show how the simulator works. 

Figures 2-7, however, provide examples of the screen 
layout and some of the features of the program. All 
figures show simulated images of a transversal slice 
through a normal human brain at 1.5 T. 

CONCLUSION/DISCUSSION 

The teaching and understanding of complex features, 
such as contrast behavior in magnetic resonance imag- 
ing, are greatly facilitated by interactive teaching tools 
such as personal computers. For the specific task of 
simulating MR image contrast behavior, we have 
developed a computer program that simulates part of 
an MR imager. Contrary to other teaching aids for MRI 
which use coarse drawings of anatomical pictures, the 
simulations of this program are based on real MR 
images and are, therefore, very realistic. An important 
feature of the program is that it is very simple to use so 
that the user is not required to spend time learning the 
tool itself. 

The simulator has been used both in classes and in 
single-student sessions. The comments from the stu- 
dents have been very positive. 
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